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Microchip Information 

Trademarks 

The “Microchip” name and logo, the “M” logo, and other names, logos, and brands are registered and 
unregistered trademarks of Microchip Technology Incorporated or its affiliates and/or subsidiaries in the 
United States and/or other countries (“Microchip Trademarks”). Information regarding Microchip 
Trademarks can be found at https://www.microchip.com/en-us/about/legalinformation/microchip-
trademarks. 

ISBN: 

Legal Notice 

This publication and the information herein may be used only with Microchip products, including to 
design, test, and integrate Microchip products with your application. Use of this information in any other 
manner violates these terms. Information regarding device applications is provided only for your 
convenience and may be superseded by updates. It is your responsibility to ensure that your application 
meets with your specifications. Contact your local Microchip sales office for additional support or, obtain 

additional support at www.microchip.com/en-us/support/design-help/client-support-services. 

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO 
REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN 
OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT 
LIMITED TO ANY IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND 
FITNESS FOR A PARTICULAR PURPOSE, OR WARRANTIES RELATED TO ITS CONDITION, 

QUALITY, OR PERFORMANCE. 

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, 
OR CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER 
RELATED TO THE INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS 
BEEN ADVISED OF THE POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST 
EXTENT ALLOWED BY LAW, MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY 
RELATED TO THE INFORMATION OR ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, 

THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR THE INFORMATION. 

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the 
buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, 
or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any 

Microchip intellectual property rights unless otherwise stated.  

Microchip Devices Code Protection Feature 

Note the following details of the code protection feature on Microchip products:  

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.  

• Microchip believes that its family of products is secure when used in the intended manner, within 

operating specifications, and under normal conditions. 

• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the 
code protection features of Microchip product is strictly prohibited and may violate the Digital 

Millennium Copyright Act. 

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. 
Code protection does not mean that we are guaranteeing the product is “unbreakable”. Code 
protection is constantly evolving. Microchip is committed to continuously improving the code 

protection features of our products. 
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 Preface  

NOTICE TO CUSTOMERS 

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(microchip.com) to obtain the latest documentation available. 

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document. 

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics, to open a list of available online help files.  

 

INTRODUCTION 

This chapter contains general information that is useful to know before using the Mixed-Signal Explorer 

GUI. Items discussed in this chapter include: 

• Document Layout 

• Conventions Used in this Guide 

• Recommended Reading 

• The Microchip Website 

• Product Change Notif ication Service 

• Customer Support 

• Document Revision History 

• Index 

DOCUMENT LAYOUT 

This document describes how to use the Mixed-Signal Explorer GUI. The manual layout is as follows: 

• Chapter 1. “Software Overview” – Important information about the Mixed-Signal Explorer GUI.  

• Chapter 2. “Usage workflow” – Describes how this GUI can be used. 

• Chapter 3. “GUI application layout and interface” – Describes all major components of  the User 

Interface 

• Chapter 4. “Delta-Sigma support through Generic SPI” – Describes the Delta-Sigma features and 

the method through which these features are supported (Generic SPI) 

• Chapter 5. “DAC Support Through Generic SPI” - Describes the support for DAC Families  

 

https://www.microchip.com/
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CONVENTIONS USED IN THIS GUIDE 

This manual uses the following documentation conventions:  

DOCUMENTATION CONVENTIONS 

Description Represents Examples 

Arial font: 

Italic characters 

Referenced books MPLAB® IDE User’s Guide 

Emphasized text ...is the only compiler... 

Initial caps 

A window the Output window 

A dialog the Settings dialog 

A menu selection select Enable Programmer 

Quotes 
A field name in a window or 

dialog 
“Save project before build” 

Underlined, italic text with 

right angle bracket 
A menu path File > Save 

Bold characters 

A dialog button Click OK 

A tab Click the Power tab 

N‘Rnnnn 

A number in verilog format, 

where N is the total number 

of digits, R is the radix and n 

is a digit. 

4‘b0010, 2‘hF1 

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1> 

Courier New font: 

Plain Courier New 

Sample source code #define START 

Filenames autoexec.bat 

File paths c:\mcc18\h 

Keywords _asm, _endasm, static 

Command-line options -Opa+, -Opa- 

Bit values 0, 1 

Constants 0xFF, ‘A’ 
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Italic Courier New A variable argument 
file.o, where file can be 

any valid filename 

Square brackets [ ] Optional arguments 
mcc18 [options] file 

[options] 

Curly brackets and pipe  

character: { | } 

Choice of mutually exclusive 

arguments; an OR selection 
errorlevel {0|1} 

Ellipses... 

Replaces repeated text 
var_name [, 

var_name...] 

Represents code -supplied by 

user 

void main (void) 

{ ... 

} 
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RECOMMENDED READING 

This user’s guide describes how to use the Mixed-Signal Explorer GUI. Other useful documents are 
listed below. The following Microchip document is available and recommended as a supplemental 

reference resource:  

- Mixed-Signal-Explorer-User-Guide.pdf  

- Mixed-Signal-Explorer-Release-Notes.pdf  

THE MICROCHIP WEBSITE 

Microchip provides online support via our website at microchip.com where files and information are easily 

available to customers. The website contains the following:  

• Product Support – Data sheets and errata, application notes and sample programs, design 
resources, user’s guides and hardware support documents, latest sof tware releases and archived 

sof tware 

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, 

online discussion groups, Microchip consultant program member listing  

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, 
listing of  seminars and events, listings of  Microchip sales of f ices, distributors and factory 

representatives 

PRODUCT CHANGE NOTIFICATION SERVICE  

Microchip’s customer notif ication service helps keep customers current on Microchip products. 
Subscribers receive e-mail notifications whenever there are changes, updates, revisions or errata related 

to a specif ied product family or development tool of  interest.  

To register, access the Microchip website at microchip.com, select Product Change Notification and 

follow the registration instructions. 

CUSTOMER SUPPORT 

Users of  Microchip products can receive assistance through several channels:  

• Distributor or Representative 

• Local Sales Of f ice 

• Field Application Engineer (FAE) 

• Technical Support 

Customers should contact their distributor, representative or field application engineer (FAE) for support. 
Local sales offices are also available to help customers. A listing of sales offices and locations is included 

in the back of  this document, under Worldwide Sales and Service. 

Technical support is available at: microchip.com/support. 

DOCUMENT REVISION HISTORY 

Revision D (May 2025) 

• Update for DAC devices support. 

Revision C (March 2025) 

• Update for f irmware update support. 

https://www.microchip.com/
https://www.microchip.com/
https://www.microchip.com/support
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Revision B (February 2025) 

• Update for Delta-Sigma support. 

Revision A (November 2024) 

• Initial Release of  this document. 
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Chapter 2.  SOFTWARE OVERVIEW 

 

Mixed-Signal Explorer GUI is a GUI software for showcasing the Microchip Mixed-Signal Evaluation boards 

capabilities. It is a component of the Mixed-Signal Explorer software package. 

For more detailed information and instruction on how to install the package and implicitly the GUI, see the following 

documentation: “Mixed-Signal Explorer User Guide.pdf” 

Below is the image of the main visual components of the GUI. 

 

(1) Connection, FW update and status bar 

(2) Analysis Panel 

(3) Analysis Tab Selection 

(4) Analysis Settings Panel 

(5) Metrics (Results) Panel 

(6) Plot Panel 

(7) Results/Settings/(Register View) Selection 

(8) Menu 
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Chapter 3.  USAGE WORKFLOW 
The application can be used in offline mode without connecting it to the MCHP USB Bridge Service. However, in 

offline mode, the application only provides Volts/Codes Analyses. 

To use the GUI in online mode (connected to an actual device), connect to a MCHP USB Bridge Service instance, 

either installed locally on the same PC with the GUI or installed remotely on an accessible host. The devices should 

be connected to the PC hosting the MCHP USB Bridge Service. The MCHP USB Bridge Service needs to be started 

as per information described in “Mixed-Signal Explorer User Guide.pdf”. The GUI does this operation for the service 

installed on localhost upon connection to localhost.  

To make a connection, use the “Connection, FW update and status bar”.  

 

Type in the first box the host of the service (the name or the IP Address, for example ‘local’ or ‘localhost’ for the 

service running on the same PC as the GUI). When connecting to localhost, the service will be started automatically, 

which momentarily opens a command prompt to do this operation. 

Then click the online red icon to establish a connection to the service. The buttons turn green on a successful 

connection to the service. 

After establishing a successful connection, select the right Device Family and Device from the dropdowns to ensure 

correct processing in the GUI. 

Next, expand the dropdown to view the available MCU boards and select one. 

 

Upon selection of the MCU board, a successful connection to the attached Evaluation Board is established, which is 

indicated by the green border surrounding the Operation Mode and the Selected Slot dropdowns. For each Device 

Family a default operation mode is provided, which can be changed from the dropdown. Also, set the desired slot. 
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The GUI can, in rare circumstances, disconnect due to an Ethernet connection timeout, which is indicated by a red 

border around the dropdowns. In such cases, disconnect the host by clicking the button and do the connection steps  

again. 

When connecting a device after the GUI has started, press the refresh button to update the device lists before the 

default refresh interval of 30 seconds. 

To continuously acquire data from the ADC, press the play button. The button will then change to a stop icon. 

 

To save 5 seconds of data while continuous acquisition is in Time Domain mode, press the Save Button. The data are 

saved as a file in the Downloads folder. While not all data is displayed in the GUI for some configuration like the SAR 

ADC 1Msps sample rate with lower periodogram lengths, all data can be retrieved from the backend using the Save 

Button and can be later replayed by using other tools like the ADC Evaluation GUI.   

To view other types of analyses running in continuous mode, click the corresponding tab in the Analysis Tab 

Selection. 

The following figure is the FFT plot for 9.76 kHz, -5.39 dBFS input signal. 
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The following figure represents the digital output code with DC input = 2V. 

 

The following figure represents the INL for a 7 kHz, 4V input signal. 
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Chapter 4.  MIXED-SIGNAL EXPLORER GUI LAYOUT 

3.1 Connection and Status Bar 

 

1. Connection group 

• ‘Service Host’ box: Here a connection to the MCHP USB Bridge Service needs to be done.  

 
o Select the connectivity type: 

▪ Select 'localhost' or 'local' for local connectivity 

▪ Select an IP address/host name for remote connectivity 

o Connection mode refers to the connection between the Mixed-Signal Explorer GUI and the 

MCHP USB Bridge Service. Once this connection is established, all GUI operations function 

identically from the perspective of the user, whether the connection is local or remote. 

o Also, target devices are accessible through USB connections using the MCHP USB Bridge 

Service.  

▪ Local host connection mode:  

• In this mode the PIC32MZ Mixed Signal Data Capture Board (EV64F02A) 

and the Evaluation Board are physically attached to the same machine 

running the GUI, referred to as local host. The MCHP USB Bridge Service 

must also run on this local host to enable the GUI to communicate with the 
USB-connected device.  

▪ Remote host connection mode: 

• In this mode, the PIC32MZ Mixed Signal Data Capture Board (EV64F02A) 

and the Evaluation Board are physically attached to a remote host 

accessible over the local network. The MCHP USB Bridge Service must run 

on this remote host as well and must be able to manage several client 

connections over TCP/IP simultaneously. 

• ‘Connect to Service’ button:  This button turns green when the GUI is connected to the MCHP 

USB Bridge Service and red when the connection fails or is not established. Clicking this button either 

connects to or disconnects from the service. A connection to the service is required for the GUI to 

operate in online mode and to gather data from the attached board. 

• Connection mode/Firmware update mode toggle button:  

If a firmware update is required, select the down arrow icon. This changes the Connection bar view to 

Firmware Update. Firmware Update is only available after a connection to the host was established. 

 
To update the firmware, follow these steps: 

1. Select the desired device 

2. Select the text box. This opens a window to select the firmware file.  

3. Select the FW Update button. A message appears on top of the bar indicating if the update 

succeeded or failed. 

• List of connected devices:  

Devices connected to the host where the MCHP USB Bridge Service is running (either local or remote) 
are displayed here and can be selected for connection. The list of attached devices automatically 

refreshes approximately every 30 seconds.  

NOTE: the dropdown cannot be accessed while continuous acquisition is running. To select a device, 

first stop the continuous acquisition. 
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• ‘Refresh Connected Devices’ button:  

This button is used to manually refresh the list of connected devices. The refresh is immediate. Use this 

button when a new device is attached or removed, instead of waiting for the 30 second automatic 
update. 

• Device Family dropdown:  

Select the correct device family. 

• Device Type dropdown:  

Select the appropriate Device to ensure correct data processing. 

• Operation Mode dropdown:  

Select the desired operation mode for the connected device. 

NOTE: The Mixed-Signal Explorer GUI selects an appropriate default operation mode. 

• Slot:  

Selecting the correct slot ensures correct output data. 

 

2. Status group 

• Errors Status Indicator:  

The red color indicates an error. Hovering over the indicator displays a tooltip showing the error 

message. Clicking on it removes the errors and sets up a clean report. For this release, the following 
scenarios can result in an error message: 

o API mismatch between the backend and GUI 

o In case data is discarded at the firmware level, service level or backend level, this 

error usually occurs when the CPU/RAM of the PCs hosting MCHP USB Bridge 

Service and the Mixed-Signal Explorer GUI reach their maximum load levels. 

o When the FFT algorithm does not detect any frequencies significantly higher than the 

noise floor. 

o When a register read fails because of simultaneous operations. 

• Acquisition status:  

This displays whether the acquisition or data processing succeeded or failed, including a message 

timestamp. 

 

• Connection status:  

Displays the current connection status for the device previously selected. 

This could be “Disconnected”, “Connected to service” or “Connected to MCU”. 
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3.2   Settings/Results toggle 

 

 

1) Clicking the Settings button displays/hides the Settings Panel 

2) Clicking the Results button displays/hides the Results/Metrics Panel for the current tab: 

Codes/FFT/INL 

3) The selected button is underlined with a lighter color. If none is underlined, then neither the Settings 

Panel nor the Results Panel is displayed. 

 
 
 
 

 

3.3 Tab selection  

 

1) Selecting one of the following items in the tab area displays the respective panel: Time Display, Spectral 

Analysis, Linearity Analysis or Bit Analysis. 

2) The currently selected tab is underlined with a lighter color. 

 
 

3.4 Acquisition group 

 

• ‘Start/Stop Continuous Acquisition’ button:  Displays a different icon based on the state of the 

acquisition. This button starts the Codes/FFT/INL acquisition based on the tab selected in the main area 

of the GUI. 

• ‘Single Acquisition’ button: This button enables the collection of one sample set of data and perform 

the necessary data processing on it. Note that data processing is done in a different library than the GUI 

(the backend) and switching tabs will not display the processed data on the exact samples acquired in a 

different tab. 

• ‘Save Data’ button: Depending on the context, this button will either save 5 seconds of Codes to a file 

in the Downloads folder, when continuous acquisition is started and the current tab is Codes or it will 

capture a snapshot of the current data, such as: Codes in the Codes tab, FFT plots and metrics or INL 

plots and metrics based on the active data set. 

 

3.5 Menu bars 

 

1) The File Menu shows the option to download (export) the current set of data from Codes into a file in the 

Downloads folder. Import option can be also used, but the length of the codes in the imported file must 

match the Samples No. in the GUI. 

2) The Help Menu will display the GUI help (User’s Guide) and an About popup, which will show the licenses of 
all the Flutter dependencies and the versions of the Service and backend library. 
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3.6 Results Pannel 

 

This panel displays the current metrics/results for the data processing corresponding to the currently selected tab.  

 

 

3.7 Settings Panel 

 

This panel displays all currently supported settings at the GUI level. 
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3.8 Chart Pannel 

 

1. Buttons: 

a. The Auto scale Y-axis button is useful when the data is out of the range of the GUI's sensible limits 

for the current plot. When the button is colored in a lighter shade, it is selected. 

b. Zoom X-axis: Clicking this button enables horizontal zoom. When the button is colored in a lighter 

shade, it is selected. 

c. Zoom Y-axis: Clicking this button enables vertical zoom. When the button is colored in a lighter 

shade, it is selected. 

To zoom in, keep the left mouse button pressed and span the area to be zoomed. After that, release the button. 

Also, another method to zoom in includes clicking the desired center of zooming then pressing CTRL+. 

To zoom out, right-click or press CTRL-. 

To restore the original view, double-click the left mouse button. 

2. Chart area: The plot is displayed here depending on the currently selected tab: Codes, FFT, INL, Bit 

Analysis. 
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CHAPTER 5.  Delta-Sigma Support Through Generic 

SPI  

4.1 Generic SPI sample rate limitation 

The Mixed-Signal Explorer GUI currently supports only a single family of Delta-Sigma devices: MCP3564xR.  

Delta-Sigma support is currently provided through Generic SPI. The backend functionality of this method 

consists of sending SPI acquisition commands from the PC to the connected ADC device; commands that are 

relayed through the Generic SPI firmware module. This method has a data rate limit of around 4 ksps, thus 

restricting the recognized signal to a maximum of 2 ksps (which is the related Nyquist frequency). The desired 

sample rate can be set in Mixed-Signal Explorer GUI with limits based on factors like baud rate, over-sampling 

ratio (OSR), internal clock, Generic SPI and ADC sample rate. The desired sample rate is rounded to achieve a 

sample period that is a multiple of 25µs which modifies the actual sample rate.  

The options provided by the sample number field (Sample no.) are powers of 2 with values around the actual 

sample rate. This ensures acquisition time is short when acquiring the same amount of data as a SAR ADC but 

with lower sample rates. 

4.2 Generic SPI FFT considerations 

When doing signal processing on the samples provided by Generic SPI, two fields must be filled with custom 

values for the FFT fundamental signal and metrics to be correctly calculated. These fields are DC leakage and 

Spectral Leakage and are measured in kHz. They need to be adjusted for Generic SPI: 0.01 kHz for a signal of 

at least 10 Hz to be detected properly. Switching tabs reloads the default values for the DC and Spectral 

Leakage fields: 0.01kHz for Generic SPI and 2kHZ for other operation modes. For Generic SPI, these settings 

change also based on the sample rate. 

4.3 Histogram 

The integral nonlinearity (INL) analysis is not currently available for Delta-Sigma ADCs, instead replaced with a 

Histogram analysis. 

 

4.4 Baud Rate 

The Baud Rate can be set in the Codes Tab. It has a minimum value of 1, a default value of 20,000,000 and a 

maximum value of 100,000,000. 
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4.5 Register View 

 

Registers can be modified for Generic SPI through Register View, accessed by clicking the yellow button in the 

ribbon on the left side of the GUI.  

Fields recommended to be modified for the current Generic SPI configuration are highlighted with a green 

outline.  

The upper part of Register View contains five buttons for various register operations. 

•  Registers can be reset to default Device values by using this button.  

•  Register values can be refreshed from the device. 

•   Register values can be saved to the device. 

•  This button saves the current register values displayed in the application to an external file. 
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•  This button can be used to import registers values from a previously saved file.  

Register values can be modified. However, some of them are changed by the backend when the operation mode 

is set to Generic SPI. This provides a working baseline for acquisitions . 

If the Mixed-Signal Explorer GUI is connected to an incorrect slot (which does not have a MCP356xR device 

connected), Register View returns false values. 
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CHAPTER 6.  DAC Support Through Generic SPI  
 

The MCP48CXBX and MCP48CXDX families of DAC devices both support the Generic SPI communication 

protocol. 

 

A sinusoidal or DC form signal can be injected into any DAC channel. While the signal is injected, Register View 

and Connection View options are disabled. 

 

If the MCP48CXBX/DX device is misconfigured in the Device Drop-down (for example, selecting an ADC device 

on slot 1 when a DAC device is already physically attached), displaying Register View corrupts the SPI 

connection. To fix this issue, reset both the GUI and the PIC32MZ Mixed Signal Data Capture Board 

(EV64F02A)." 
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INDEX 

Alphabetical order Meaning 

ADC Analog-to-digital converter 

BE Big Endian 

CLI Command Line Interface 

CSV Comma Separated Values 

DAL Device Access Layer 

DNL Differential Nonlinearity 

FFT Fast Fourier Transform 

FW Firmware 

GUI Graphical User Interface 

HW Hardware 

INL Integral Nonlinearity 

INSTALLDIR Installation Directory 

IP Internet Protocol 

ksps Kilo-Samples Per Second 

LE Little Endian 

MCHP Microchip 

MCU Microcontroller Unit 

S/N Serial Number 

SW Software 

Rev Revision 

PC  Personal Computer 

SPI Serial Peripheral Interface 

TCP Transmission Control Protocol 

USB Universal Serial Bus 

 


